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Everything you need to teach 
 handwriting at primary level  

using Letter-join. 

Try the new Letter Families activity.  
Choose from Letter-join cursive or  
printed fonts to play and practise.
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BROWSERS

Letter-join on iPads and tablets 
Letter-join access on iPads and tablets is included with 
school subscriptions. Letter-join’s fun, touch-screen 
activities are compatible with most Apple, Android and 
Windows tablets.

Free home access for your children 
Letter-join includes free access for pupils to log in to 
Letter-join at home on their PCs and tablets.  
Log-in details are sent by e-mail to schools at time of 
purchase.

Handwriting Lesson Planners 
Lesson Planners, from Early Years through to Year 6, for 
teachers wishing to follow a structured handwriting 
teaching plan. See page 8 for details.

Handwriting Policy Document 
Letter-join includes a curriculum-based Handwriting Policy 
that can be personalised by schools.

Letter-join in the classroom 
Letter-join is an online handwriting resource for teaching 
printed and cursive handwriting on classroom interactive 
whiteboards. It includes animations, touch-screen activities, 
cursive and printed fonts, lesson planners and access to 
hundreds of practice worksheets.

Letter-join fonts for MS Word 
School staff can create homework sheets, newsletters, 
posters and labels using Letter-join fonts in MS Word.  
See pages 6 and 7.

Alternative letterforms 
The Letter-join cursive font includes alternative letterforms 
for f, k, w, x and z that are used on all resources. The 
printed font has alternative letterforms for f and k. 

Letter-join practice worksheets  
Letter-join contains worksheets and printouts in PDF format. 
These will use your school’s preferred letterforms.

SET A TASK

Easily share a Letter-join activity 
with pupils at home 
Create handwriting learning tasks for 
pupils to use at home. See page 42.

NEW! Letter Families activity
Suitable for EYFS and KS1, 

the Letter Families activity 

reinforces the different letter 

shapes and shows children 

the correct way to write the 

letters.  

Find under the ‘Fun’ tab.

Letter-join now includes activities and resources 
using our new font, Letter-join Print Plus which 
aligns with DfE Phonics Guidance 1 April 2021.

Letter-join Handwriting Manual

Letter-join Print 
Plus font has 
simple exit strokes 
for letters that 
‘end on the line’. 
The example 
(right) shows the 
new font in 
Letter-join Phonics.

This is Letter-join!

Resources using the new Print Plus font include: 
• a new supporting supplementary Lesson 
Planner for Early Years. 
• all lower case letters and words
• all of the Phonics activities
• all games and activities
• all EYFS and KS1 worksheets

 

A4 Phonics posters for classroom display.

Print Plus alphabet on A4 sheets for wall display.



Animations with spoken 
instructions

Touch-screen activities for 
IWBs, iPads and tablets

Choose a letter to watch Practice worksheets accompany 
all sections
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Letter-join workflow: animation to worksheet
Animations for individual letters include voiced instructions 
and link to an accompanying practice worksheet.

The Letter-join menu  CLASSROOM SET-UP
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Click on the Info button on any Letter-join web 
page for essential classrrom information.

Teachers’ 
Information Panel

Letter-join  
VIDEOS

CHANGE  
YOUR 

CLASSROOM 
FONT HERE! 

Essential videos and 
presentations to help 
get the most from 
Letter-join.

How to get your 
pupils using 
Letter-join at home.

Set handwriting 
learning tasks for 
pupils at home. 

Find out more on  
Page 42.

Instruction  
Guides
l	 Handwriting Lesson 

Planners (PDF 
format)

l	 Handwriting Manual 
for teachers

l	 Handwriting Policy

l	 Fonts guide 

l	 Fonts in Microsoft 
Word

l	 On-line Word 
Processor

l	 Setting up tablets

l	 Word Animator 
guide

l	 Worksheet 
Generator guide

l	 Instructions for 
pupils to use 
Letter-join at home

l	 Handwriting 
Manuals for pupils 
and parents

Classroom Set-up



apple

Please make sure that the Letter-join fonts are 
installed - see page 43.

With the Letter-join fonts installed on your 
computer open MS Word and check that the 
fonts are displayed in the font list. 

If the Letter-join fonts are not listed, re-start 
MS Word.

How to switch on Contextual Alternates: 
• Select text. 
• Select Format > Font (or Ctrl D). 
• Select the ‘Advanced’ tab. 
• Tick the ‘Use Contextual Alternates’ button.

This option has to be selected every time MS 
Word is re-opened or alternatively a Word 
template can be created with Contextual 
Alternates already enabled.

Switching on Contextual 
Alternates in Microsoft Word
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CONTEXTUAL ALTERNATES SWITCHED ON

CONTEXTUAL ALTERNATES SWITCHED OFF

Create a Word Template to keep 
Letter-join’s font preferences 
You can create a time-saving template to use that has 
the Letter-join font selected with contextual alternates 
enabled.

Open a new Word document and select Ctrl + D. 
Choose the Letter-Join font. Select the Advanced tab 
and enable ‘Use Contextual Alternates’ then click OK.

Navigate to File > Save as. In the ‘Save as type’ field 
change from the default ‘Word Document (*.docx)’ to 
‘Word Template (*.dotx)’ and name the file.

LETTER-JOIN FONTS IN MICROSOFT WORD

 

Distribute this file to all staff who will use the Letter-
join fonts in MS Word. When the template file is 
opened both the correct font and the ‘Use Contextual 
Alternates’ option are automatically enabled.

Word Template

• Select text.

• In MS Word, select Format > Font (or Ctrl D).

• Select the ‘Advanced’ tab.

• Tick the ‘Use Contextual Alternates’ button. 

This option has to be selected every time MS Word is re-opened 
or alternatively a Word template can be created with Contextual 
Alternates already selected, as shown on the right.

Contextual Alternates

When using any of the Letter-join fonts in MS Word 

it is important to select the Contextual Alternates 

option to correctly reproduce the cursive letterforms 

and use the correct joining strokes.

How to switch on Contextual Alternates
With the Letter-join fonts installed on your computer the Letter-
join fonts will be displayed in the MS Word font list. If they are 
not showing, re-start MS Word for the fonts to show.

✔

CONTEXTUAL ALTERNATES SWITCHED OFF 

Lead-in lines and joins are formed correctly

✘
Lead-in lines are missing and joins are incorrectly formed

CONTEXTUAL ALTERNATES SWITCHED ON

Lead-in line 
missing

Wrongly shaped 
letters that overlap

Display cursive fonts correctly in MS Word 

When using any of the Letter-join cursive 
fonts in Microsoft Word it is important to 
switch on the Contextual Alternates 
option to correctly reproduce the cursive 
letterforms and use the correct joining 
strokes between letters. Please set-up as 
shown below. 
 
About Contextual Alternates
Contextual Alternatives is a typographical 
term for correctly joining cursive letters 

together.
 

Letter-join font software compatibility
As well as MS Word, Contextual 
Alternates is auto-selected by Apple 
Pages. For programmes that do not have 
Contextual Alternates, please use the 
Letter-join Basic font.

apple

Create a Word Template to keep 
Letter-join’s font preferences 
You can create a time-saving template to use that has 
the Letter-join font selected with contextual alternates 
enabled.

Open a new Word document and select Ctrl + D. 
Choose the Letter-Join font. Select the Advanced tab 
and enable ‘Use Contextual Alternates’ then click OK.

Navigate to File > Save as. In the ‘Save as type’ field 
change from the default ‘Word Document (*.docx)’ to 
‘Word Template (*.dotx)’ and name the file.

LETTER-JOIN FONTS IN MICROSOFT WORD

 

Distribute this file to all staff who will use the Letter-
join fonts in MS Word. When the template file is 
opened both the correct font and the ‘Use Contextual 
Alternates’ option are automatically enabled.

Word Template

• Select text.

• In MS Word, select Format > Font (or Ctrl D).

• Select the ‘Advanced’ tab.

• Tick the ‘Use Contextual Alternates’ button. 

This option has to be selected every time MS Word is re-opened 
or alternatively a Word template can be created with Contextual 
Alternates already selected, as shown on the right.

Contextual Alternates

When using any of the Letter-join fonts in MS Word 

it is important to select the Contextual Alternates 

option to correctly reproduce the cursive letterforms 

and use the correct joining strokes.

How to switch on Contextual Alternates
With the Letter-join fonts installed on your computer the Letter-
join fonts will be displayed in the MS Word font list. If they are 
not showing, re-start MS Word for the fonts to show.

✔

CONTEXTUAL ALTERNATES SWITCHED OFF 

Lead-in lines and joins are formed correctly

✘
Lead-in lines are missing and joins are incorrectly formed

CONTEXTUAL ALTERNATES SWITCHED ON

CLASSROOM SET-UP

Letter-join cursive and printed fonts 
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USING IN MS WORD 
The Letter-join fonts included 
in school subscriptions can be 
downloaded from a school’s Letter-join 
Admin page to use in MS Word.  
See ‘Installing fonts’ page 43.

 
CLASSROOM ONLINE ACTIVITIES 
Class teachers can choose Letter-join 
fonts via ‘Classroom Font Options’.  

To do this click 
the ‘Info’ button 
on any Letter-join 
page. Font choice is 
available on the following Letter-join 
activities: Magic Words, Worksheet 
Generator, Phonics, Word Animator, 
Word Bank and Write it Right!

Use the Letter-join Word Processor to 
produce documents with Letter-join 

fonts, without having to download to 
a computer. 

ALTERNATIVE LETTERFORMS 
Cursive fonts will use the alternative 
letterforms that have been chosen by 
a school for the letters f, k, w, x and z.

Printed fonts will use the alternative 
letterforms that have been chosen by 
a school for the letters f and k.

CLASSROOM SET-UP

the dog ran

the dog ran

the dog ran

the dog ran

the dog ran

the dog ran

Letter-join Air Plus

Letter-join Air Plus is used when wanting to teach 
continuous cursive letters that are not joined.

Letter-join Air No-lead

Letter-join Air No-lead does not include a 
lead-in line and the letters are not joined.

Letter-join Print

Letter-join Basic

Letter-join Print matches the letter style  
used in Letter-join to teach printed letters.  

Letter-join Basic is designed for use with 
PowerPoint and Smart Notebook. 
It is based on Letter-join Plus.

Letter-join No-lead

Letter-join No-lead does not include the lead-in 
line at the start of each letter but has a 
lead-out line that joins to the following letter.

Letter-join Plus

Letter-join Plus is the font most widely used by 
Letter-join school subscribers. It is a continuous 
cursive font with lead-in and lead-out lines.

the dog ran 

Letter-join Print Plus

Letter-join Print Plus has simple exit strokes 
for letters that end ‘on the line’. 



YEAR 1
MODULE 2 
80 lessons 

Capital letters,  
Printed letters,  

Numbers, Punctuation  
and Other Symbols.

YEAR 2
MODULE 3 
90 lessons

Increase fluency and 
speed of children’s  

handwriting through 
regular practice.

YEAR 3      
MODULE 4 
60 lessons

Improve legibility,  
consistency and  

quality of  
handwriting.

EARLY YEARS
MODULE 1 
70 lessons

EARLY YEARS 
PRINTED LETTERS 

SUPPLEMENT
50 lessons Pre-cursive patterns 

and continuous 
cursive, lower-case 

letters.

Start teaching 
handwriting using 

printed letters.

YEAR 4      
MODULE 5
60 lessons 

Apply  
size-appropriate 

handwriting to all areas 
of the curriculum.

YEAR 5      
MODULE 6
60 lessons 

Combine fluent 
handwriting with other 

subjects across the 
curriculum.

YEAR 6   
MODULE 7
60 lessons 

Develop more of a 
personal handwriting 
style and write with 

automaticity.
Letter-join Lesson Planners and their corresponding 
worksheets links can be accessed from the ‘Lesson 
Planners’ option on the Teachers Info page.
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Handwriting Lesson Planners

 

HOW TO DOWNLOAD LESSON PLANNERS

Click the ‘Info’ button on any Letter-join page 
 and choose ‘Lesson Planners’.

Letter-join Handwriting Lesson Planners can be used to teach handwriting by starting with 
printed or cursive letters (with or without a lead-in line) using a whole school approach.

Letter-join Handwriting Lesson Planners cover each 
of the key stage requirements and are written by 
teachers and editors with expertise in EYFS, KS1 
and KS2. 

They are developed in keeping with the National 
Curriculum and use Letter-join’s resources to 
provide a thorough and interesting way to teach 
handwriting.

Early Years lessons cover all the lowercase 
letters; either cursive or printed.

Handwriting practice is combined with SPaG 
topics for SATs revision.

Longer passages of text and dictation exercises 
increase speed and stamina of handwriting.
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Letter-join Lesson Planners include many activities 
and specific worksheets and are an ideal way to 
work through resources.

The new ‘Printed Letters supplement’ can be used 
by schools that wish to begin teaching handwriting 
using printed letters.

Lesson plans progress through a series of 
worksheets combining handwriting practice with 
SATs revision topics for KS1 and KS2.

They continue through to exercises that increase 
speed and stamina in handwriting as well as fun 
items that explore handwriting creatively.

Lesson Planner module progression

LESSON PLANNERS



Letter-join offers the option to start 
teaching handwriting using printed letters, 
for all resources and worksheets, before 
moving on to cursive handwriting. 

Patterns and pre-cursive shapes can  
be challenging for young pupils,  
but Letter-join has all the  
resources needed to introduce 
joined-up handwriting strokes.

Letter-join’s animations present 
pre-cursive patterns with fun sounds 
that can be copied by air-writing or 
by tracing on IWBs, tablets and, most 
importantly, by practising with a pencil on 
printed worksheets. 

This naturally leads on to the introduction 
of real letters. Watching and copying the 
shapes of letters and the various joining 
techniques will enable pupils to learn to 
write simple words in a cursive style at 
this early stage.

Early Years 
Foundation 
Stage
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Lesson Planner

To complement Letter-join worksheets for 
patterns, letters and words, children can 
choose Letter-join’s touch-screen activities to 
enhance writing skills.

EYFS touch-screen 
activities  

PhonicsMatch 
Combine handwriting and 
phonics with Letter-join’s fun, 
interactive phonics resources. 

Letter Families 
Reinforces the different letter 
shapes and shows children the 
correct way to write the letters. 

Magic Patterns 
A selection of patterns and cursive 
shapes for tracing.

Magic Words
Enter any word to trace on a variety 
of colourful backgrounds.

LetterMatch
LetterMatch is an activity to teach 
children the names and sounds of 
the letters of the alphabet. 

When the sounds have been 
learned, play a matching pairs 
game to reinforce the learning task. 

Ideal for children to use at home 
on iPads and PCs for independent 
learning. Find LetterMatch under 

the ‘Fun’ tab.
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LetterMatch 
Helps teach the names and sounds 
of the letters of the alphabet.

Printed & 
cursive fonts
Use any Letter-join 
printed or cursive fonts 
for all resources. 

Choose the font that’s  
most appropriate for  
your class. 

MODULE 1  & PRINTED LETTERS  
SUPPLEMENT



Letters and words made simple
Watch, practise, trace and copy – the easy way 
to learn cursive handwriting.
Letter-join introduces animations of 
the letters of the alphabet in a 
progressive manner starting with 
‘long ladder letters’ and building up 
to the more complex letter shapes. 

Each letter is presented as an 
animation with a spoken description.

There are also opportunities to ‘try’ 
letters and words on IWBs and 
tablets. 

     

Each set of letters is followed by 
accompanying words illustrating the 
joining methods of the letters just 
practised. 

The letter and word sets can be 
printed in three different sizes for real 
handwriting practice. 

Each set of words 
also includes a 
worksheet which 
uses each of the 
words in a sentence 
helping children to 
understand the 
word in context.

LETTER-JOIN HANDWRITING MANUAL   13   

EYFS

WITHOUT LEAD-IN LINE OPTION

Change a Letter-join font, click the ‘Info’ 
button on any Letter-join page and 
choose  ‘Classroom Font Options’.

Animations of letters and words and 
associated worksheets are available 
without lead-in lines. 

Use Letter-join’s Word Animator to 
create an animation of any word.

These can be saved into Word Banks 
for your children to use at home.

WORD ANIMATOR 
Create animations  

for any word

CLASSROOM FONT OPTIONS

The new Letter-join Print Plus font and Early Years Printed Letters 
Lesson Planner, allows teachers to choose to start teaching 
handwriting using a printed style first.

Choose interactive activities and worksheets as 
a foundation to handwriting.

Interactive whiteboard display allows for whole class involvement.

Letter-join provides a selection of fun 
pre-cursive patterns for EYFS pupils 
that cover all handwriting 
movements. These encourage fine 
and gross motor skills as a 
foundation to cursive handwriting. 

Letter-join’s pre-cursive patterns are 
grouped into logical sets of similar 
shapes, and each pattern is 
animated, accompanied by exciting 
sounds. The patterns can be traced 
over on IWBs or tablets. 

Presented large on the IWB, 
Letter-join is perfect for practising 

Pre-cursive patterns cover all writing shapes.

Watch patterns, such as jellies, with fun sounds.

Fun worksheets are available as PDFs for all 
the pattern sets for handwriting practice 
using pencils and crayons.

Start handwriting using  
printed letters

Develop writing skills with pre-cursive patterns 
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EYFS

Word banks can be easily made into 
spelling lists and word searches and can 

be accessed by children at home.

WORD BANKS
Make class word banks



Key Stage 1
Handwriting can be fun and Letter-join 
will help reinforce handwriting throughout 
KS1 with a mix of touch-screen and 
traditional activities.

KS1 is the time to introduce new 
letterforms including capital letters, 
numbers and punctuation. To show the 
correct letter construction, Letter-join 
includes animations for all of these, and 
provides ready-made worksheets for 
labelling and form-filling using capital 
and printed letters.

Key Stage 1 children should be working 
to produce neater handwriting with 
consistent spacing. Handwriting speed can 
be practised and developed using 
Letter-join’s dictation exercises.

Teachers can set home learning tasks for 
their class, and pupils can log into 
Letter-join at home, on iPads and 
tablets, to access the tasks and use 
Letter-join’s other fun activities.  
See page 42 for details.
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Letter-join offers a series of 
worksheets to support KS1 SATS 
which are not only great for 
improving handwriting, but are also 
perfect for the revision of spelling, 
punctuation and grammar.  
 
There are many fun worksheets 
aimed to boost your children’s 
confidence so they are SATs ready.

Worksheets can be downloaded from 
Resources > Printouts > Key Stage 1 
and are also used in Handwriting 
Lesson Planner, Module 3.

KS1 SPaG Revision
Lets try...

MODULES 2 & 3
Lesson Planner
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KEY STAGE 1

Developing pupils’ handwriting skills

Reach KS1 
handwriting 
standards
•	 Demonstrate the correct methods 

for writing upper and lower case 
letters with the correct joins.

•	 Show how to form numerals of 
the same size that sit on the 
base line.

•	 Teach how to write printed letters 
and use Letter-join’s animations 
and worksheets to practise how 
they are used.

•	 Ensure that pupils know how 
much space to leave between 
words.

•	 Encourage pupils to write longer 
passages of text to build up 
endurance using the Dictation 
Exercises.

•	 Use Letter-join’s worksheets to 
ensure that letters sit on the 
base line and are consistent in 
size with correctly formed 
ascenders and descenders.

KEY STAGE 1

Letter-join worksheets 
in ‘Resources’

Capital letters, printed 
letters, numbers and 
symbols can be practised 
using real handwriting on 
the many worksheets 
provided in ‘Resources’.

For the complete listing of 
printout sheets, Letter-join 
users can visit Resources > 
Printouts. See page 24.

Practise number writing

Letter-join includes a full set of times 
tables worksheets from 2 through to 
12 times tables which are great for 
practising number writing. They are 
provided in look, trace and copy 
format which are great for homework 
sheets or five-minute fillers.

Introduce form-filling 

Pupils can learn how to write within 
the constraints of a form using 
printed and capital letters. Letter-join 
includes a selection of forms for Key 
Stages 1 and 2.

Try ‘More Letters’ for touch-screen activities and printouts 
for capitals, numbers and printed letters.

Numbers and symbols

Touch-screen activities can be 
used for immediate practice 
of numbers and symbols. For 
real handwriting practice there 
is varied and interesting 
selection of worksheets.
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Capital letters

Letter-join’s animations teach 
how to form capital letters 
correctly. To accompany 
teaching, there are Letter-join 
worksheets specifically for 
practising capital letters e.g. writing names, 
form-filling, crosswords and word searches.

Printed letters

KS1 activities for practising 
printed letters include labelling 
diagrams, writing email 
addresses and worksheets that 
include a mixture of printed and 
capital letters, for instance when  
addressing an envelope.



KEY STAGE 1

Magic Words is a great way for KS1 
pupils to type in their own words and 
practise their handwriting using the 
touch-screen capabilities of iPads and 

tablets. Class teachers are able to 
select the Letter-join font they wish 
their pupils to practice with. There are 
five exciting, colourful backgrounds 

and a simple star reward function, 
which pupils will enjoy using on their 
tablets at school and at home.  

Letter-join’s Dictation Exercises are a 
great way to introduce to speedy 
writing and help build up stamina.  

Dictation Exercises help with children’s 
listening skills and in learning how to 
check and edit their writing.

The dictation exercises for KS1 start 
with a simple spelling list, a list of 2 
digit numbers and an easy poem.

Practise speedy writing with Dictation Exercises

Letter-join’s Magic Words – touch-screen activities
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A dictation list written out as a first draft and a final copy. 
See page 30 for more information about Dictation Exercises.
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KEY STAGE 1

Using the familiar format 
of long ladders, curly 
caterpillars, one-armed 
robots and zig-zag 
letters, Letter-join’s 
Letter families 
worksheets can be 
printed out for tracing 
and copying.

Additionally, under the 
‘Fun’ tab, a Letter Family 
touch-screen activity has 
been added to help 
reinforce the different 
letter families.

Try Letter Families worksheets and touch-screen activity 
Help pupils become familiar with similar letter shapes and become confident at writing differently formed characters.

   19   

Spelling worksheets include all 
the long vowel sounds

Sequencing sentences with 
guidelines for handwriting practice

Prepositions presented with 
colourful graphics

Handwriting worksheets 
Handwriting and spelling go together and Letter-join 
provides many spelling worksheets for practising cursive 
handwriting. 

These include: pangrams, high frequency words, cloze 

sentences, word spacing and joining techniques. See 
pages 26 to 28 for more worksheet examples.

SPaG practice worksheets
There is also series of worksheets which specifically cover 
spelling, punctuation and grammar practice. As well as 
providing excellent revision and homework sheets, the 
printouts also enhance pupils’ cursive handwriting.
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Practise topic spellings using 
the Word Animator and the 
On-line Word Processor

Let’s try...

Build animations of words for whiteboard and tablet 
practice and send to the Letter-join Word Processor 
to create ‘look, trace and copy’ spelling lists.

Build a bank of 
animated topic words 
for pupils to re-play 
and trace using the 
Word Animator.

1

Share classroom Word 
Banks with pupils to 
watch and practise.

2

Choose to make a  
spelling list or word 
search to extend Word 
Bank activities.

3

See page 32 for details 
of the On-line Word 
Processor and page 34 
for details of the Word 
Animator.
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Ready for the final round of handwriting 
challenges? When pupils master these 
they’ll be true handwriting champions! 

Building on KS1 skills, pupils will be 
writing passages of text neatly and 
speedily, labelling diagrams using printed 
letters appropriately and filling in forms 
using legible writing. 

Letter-join’s resources will help pupils 
acquire a feel for neatness and quality in 
their final handwritten work. The dictation 
resources will help to develop handwriting 
stamina when writing.

With the support of Letter-join,  
pupils will have covered all the criteria 
necessary by the end of Year 6 to reach 
the standards set out in the National 
Curriculum for handwriting.

Key Stage 2

Example of tracing topic words on a tablet using 
a classroom Word Bank.

Lesson Planner

MODULES 4 to 7



KEY STAGE 2
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The National Curriculum 
tasks Key Stage 2 pupils 
to aim for quality, speed 
and stamina.

Letter-join’s resources will help to 
attain these aims and provides 
worksheets and exercises to help 
improve handwriting.
 
The National Curriculum 
criteria for KS2 handwriting 
includes:

Quality: 
Ensure that letters are of consistent 
size with equal word spacing and 
that ascenders and descenders are 
parallel and do not interfere with the 
writing on the above or below lines.

Speed:  
Improve speed of handwriting to 
allow creative writing to take 
precedence over the task of 
handwriting and be able to take 
‘quick notes’ at a faster pace.

Stamina:  
Have the strength and mobility to be 
able to write for longer periods of 
time without fatigue.

Pupils are expected to have full 
knowledge of different kinds of 
handwriting for different purposes 
Including:

•	 Neat, joined, cursive letters  
for writing passages, large 
amounts of text, lists and letters.

•	 Printed or capital letters for 
posters, presentations, headings, 
labelling and form filling.

•	 Speedy handwriting for note-taking 
and dictation where neatness is 
not as important and shortcuts can 
be used, such as ‘+’ instead  
of ‘and’.

Introducing Letter-join’s advanced handwriting exercises 
to reach KS2 National Curriculum standards.

Curriculum topics
Letter-join provides opportunities to link handwriting practice to 
other areas of the curriculum and combines handwriting practice 
with other KS2 tasks such as statutory word lists.

Advanced form-filling
Promote accuracy and neatness of 
printed and capital letters with 
advanced form-filling worksheets.

Worksheets can be found in the ‘Resources’ section of Letter-join.

Accomplishing neat handwriting
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KEY STAGE 2

Challenging dictation 
exercises for KS2
These exercises will help with stamina, 
speedy note-taking and encourage 
proof-checking and editing.

Extract from Hansel 
and Gretel

...it was 
built of 
bread and 
covered 
with 
cakes...



		

		

Dictation Exercises

On-line Word Processor

Improve listening skills as well as 
handwriting speed, accuracy, 
note-taking and editing.

Key Stage 1
•	A selection of CVC words, a list of numbers and 

an easy poem.

•	Harder dictation exercises: a list of phrases, 
easy additions and a three-verse poem.

•	Sentences and paragraphs using years 1 and 2 
common exception and high frequency words.

Key Stage 2
•	More challenging exercises: a shopping list, 

complex numbers and a longer written passage.

•	Dictation exercises using extracts from 
traditional stories and poems.

Create and save documents using any 
of the Letter-join fonts. 
An on-line alternative to MS Word for creating 
spelling lists, classroom presentations and 
much, much more! The on-line Word Processor 
does not require Letter-join fonts to be 
downloaded onto computers. 
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RESOURCES

		

Worksheet Generator
Create handwriting worksheets for spelling 
lists, sentence sheets and posters. 
Choose any of the seven Letter-join fonts to 
produce worksheets. Worksheets are created within 
internet browsers and your school’s choices of 
preferred letterforms will be used. They can be 
saved as PDFs.

Page 29Page 30

		

Warm-up Exercises
Develop gross and fine motor skills. 
Pupils will enjoy Letter-join’s fun warm-up 
exercises for gross and fine motor skills.  
They can be found in the Letter-join Lesson 
Planners and on-line under Resources.

Find on-line in ResourcesPage 32

Resources

BUILD A  
WORD BANK

3
PRACTICE  
FOR PUPILS

4
CREATE
ANIMATION

2
TYPE A WORD

1
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Word Animator
Create animations of words to save into classroom Word Banks.

Printout Sheets 
There are hundreds of worksheets divided into five sections 
which can be printed with your choice of font and use a school’s 
chosen alternative letterforms. 

Page 34

• Printout sheets
• Word Animator
• On-line Word Processor

• Dictation Exercises
• Worksheet Generator 
• Warm-up Exercises

Pages 
26 to 28



Worksheets to consolidate correct letter formation using 
sentences that contain all the letters of the alphabet. 

Word lists 
 

MFL worksheets 

SPaG worksheets 
A growing series of worksheets combining handwriting practice with KS1 and KS2 SATs revision.

Missing words sentences using 
words from the word lists for 
Years 3-4 and Years 5-6.

Spelling lists and sentences 

Punctuation practice in the 
context of meaningful sentences.  
Worksheets cover all the 
punctuation requirements.

A series of exercises covering the 
grammar topics required for KS1 
and KS2 SATs such as adjectives 
and prepositions.

Practise spelling rules and patterns 
with trace and copy word lists then 
reinforce with complementary 
‘missing words’ worksheets.

Punctuation Grammar

Cloze exercises

Worksheets combining handwriting 
practice and French/Spanish 
vocabulary. 

Spelling words, as listed in the 
DfE’s English Programmes of Study, 
in look, trace and copy format.

Pangrams
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RESOURCES

High frequency words 
100 high frequency words 
to trace and copy for EYFS 
and KS1 in large, medium 
and small sizes. 

Printouts

Letter families 
Colourful worksheets to help with the different families of letter shapes. 

Sequencing sentences 
Write sentences in order to 
form short narratives. Two 
different levels for years 
1-2 and years 2-3.
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Letter-join includes hundreds of printouts 
using your alternative letterforms All printouts are available 

in two font styles:

• WITH lead-in lines

• WITHOUT lead-in lines

KS1 printouts are all 
available in printed fonts.

Font
style

Cursive worksheet examples

Cursive worksheet examples continued



A4  
HIGHLIGHTED 

PAPER
Choose from 3 
different line 

widths

Worksheet Generator
Create your own handwriting worksheets  
for spelling lists, sentence sheets and posters.
Each classroom account can choose any of the five 
Letter-join fonts to produce printouts using the 
Worksheet Generator.

Worksheets are created within internet browsers and 
your school’s choices of preferred letterforms for f, k, 
w, x and z will be used.

Spelling Lists Sentence Sheets Posters/Freestyle 

 

HINTS AND TIPS
Changing the font 
You can quickly change the font 
via the ‘Info’ button and choose 
‘Classroom Font Options’.

The font is not joining 
correctly on the Worksheet 
Generator. 
Do not use Internet Explorer 
for Letter-join! The Worksheet 
Generator will produce fonts 
correctly if using Google 
Chrome, Firefox or Safari.

PRINTING WORKSHEETS

How do I save worksheets 
created using the Worksheet 
Generator? 
The Google Chrome browser has 
a facility to save pages as PDF 
files. Create your worksheet as 
normal using Google Chrome 
and select Ctrl P then change 
‘Destination’ to ‘Save as PDF’. 

The worksheets are printing 
very faint and the guidelines 
are not showing. 
Some laser printers can struggle 
to print from a web page. Save 
the worksheet as a PDF (see 
above) and print from the PDF. 

The tracing words are 
printing in black when I 
generate a worksheet. 
If using Firefox, to print the 
tracing words in grey please 
select the ‘Print Background’ 
option from Page Setup. 
Firefox: File > Page Setup > tick 
Print Background.

The lines are over-running 
when I print a generated 
worksheet. 
We recommend a maximum 
number of letters/words/lines 
for each character size on 
the Worksheet Generator. If 
exceeded text lines may over-
run. Try reducing the number of 
words per line.
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RESOURCES

In three sizes with options to 
show all the guidelines or 
the baseline only.

In three sizes with options to 
hide or show guidelines and 
with trace or trace and copy 
options.

In three sizes with options 
to show guidelines, baseline 
only or no lines at all, and 
to range text left or centred.

A series of form-filling exercises for all key stages to help 
teach the formation of printed and capital letters.

Posters and Handouts
Alphabet banners 

All the letters of the alphabet, each on an A4 sheet, to 
print out for displaying in the classroom or for pupils to 
colour in. Available as cursive, capital and printed letters.

Microsoft Word templates 
Designed to match a 
standard handwriting book 
style. Choose from 4 sizes.

A selection of worksheets for practising printed letters, 
covering curriculum-based topics for all key stages. 

Numbers, Capitals and Printed 
Letters Worksheets

A simple form for early years. A more advanced form for KS 1.

Times tables worksheets 

Labelling exercises

Form-filling exercises

Alphabet printouts 
A4 printouts for cursive, printed and capital letters 
which will print using your school preferred 
letterforms for f, k, w, x and z. These are useful for 
sending home so that parents know which letterforms 
are used at school.

Trace and copy worksheets for tables facts to 12 x 12.

Lined writing paper
Choose traditional ruled 
paper or highlighted, 
yellow rules from the MS 
Word templates.
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A typical Key Stage 1 Dictation Exercise using simple sentences.

Dictation Exercises are found under the Resources tab.

‘Brush your Teeth’ Example

   31   

RESOURCES
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Increase the pace of children’s note-taking
Dictation Exercises to speed up handwriting

The exercises are presented as sound files which are 
firstly played at normal speed for pupils to become 
familiar with the text. The text is then played slowly for 
pupils to write down.

The spoken text is played back again at normal speed 
allowing pupils to fill in any gaps that they may have left 
in their written draft or to correct any errors.

The final text can then be displayed on screen or printed 
out so that pupils can re-write the text in their best 
joined-up handwriting making any corrections on the way.

You can choose to display the dictation text with or 
without lead-in lines.

The National Curriculum states that 
by the end of Key Stage 2 pupils 
should have ‘fluent, legible and 
eventually, speedy handwriting’.   

Writing notes when a person is speaking can be a tricky 
task, but dictation is a very good exercise to build 
proficiency and speed in handwriting as well as supporting 
spelling and editing skills.

Letter-join’s dictation exercises range from ‘Easy’ to 
‘Challenging’ to cater for pupils in KS1 and KS2. They are 
simple and fun, and can be practised at school as well as 
at home. 

Example of Key Stage 1 ‘Number sentences’ dictation exercise.

RESOURCES

A selection of 
CVC words, a 
list of numbers 
and an easy 
poem.

A list of phrases, 
an easy number 
sentence and a 
three-verse 
poem.

Years 1 and 2 
common 
exception and 
high frequency 
words.

A shopping list, 
complex 
numbers and a 
longer written 
passage.

Longer passages 
using extracts 
from traditional 
stories and 
poems.

How to use Letter-join Dictation Exercises
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Click ‘File’ from within the 
Word Processor window 
and select ‘Open’. 

Choose ‘Look, trace and 
copy Spellings’ from the 
‘Templates’ section.

Other templates are 
available.

1

2

3

4

7

5

6

Scroll over the heading to select ‘Spellings title’ 
and overwrite the heading for your spelling list.

Open the 
Letter-join 
On-line Word 
Processor from 
the Resources 
tab.

Continue until the table is complete.

Once the list has been created, select all of the text to 
change it to your preferred font.

You can print directly to your printer or you can save 
as a PDF by changing the destination of the printer to 
‘Save as PDF’.

Now place your cursor in the cell underneath 
‘Trace’, or use the Tab key, and type your first 
word again. The ‘Trace’ text will be grey.

Scroll over ‘Insert date’ and overwrite the date or 
select an option from the pull-down menu.

Place your cursor in the cell underneath Look, and 
type your first word. The ‘Look’ text will be black.

RESOURCES

You can save your worksheet using ‘Save’ at the top 
left of the Word Processor window. 

To print your spelling list use the Printer Icon at the 
top left of the Word Processor window. 

Make a spelling list with the Letter-join on-line Word Processor
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Ready-to-use Letter-join templates
The Letter-join Word Processor includes a growing number 
of templates including lined and highlighted paper, 
Spelling List and Year 2 Common Exception words for 
classroom display. Staff can customise templates on-line 
by typing new words and choosing any Letter-join font.

The Letter-join On-line Word Processor 
allows you to create and save documents 
using any of the Letter-join fonts with a 
school’s pre-selected letterforms.

Use to create worksheets, posters and 
notices when using a computer that does 
not have the Letter-join fonts or MS Word 
installed.

How to use
Log in to your Letter-join classroom account, 
select the ‘Resources’ tab and choose  
‘W Processor’. You can either start typing 
to create a new document using familiar 
commands, or open any of the ready-to-use 
template files to overwrite with your own 
text and images. 

Please use the ‘File’ option 
on the menu bar WITHIN 
the browser window to 
open, save and print 
documents.  
Do NOT use Ctrl-S or 
File > Save etc. on your 
computer’s menu bar.

As well as each classroom’s 
saved documents, Letter-
join’s templates and 
examples can be opened 
and edited.

Documents are saved for each classroom account. 

When printing, ensure that ‘Print background images’ is 
selected to print worksheets correctly.

Opening, saving and printing documents

‘Look, trace and copy’ spelling list 
Instructions can be found under the Info button. 

Letter-join On-line Word Processor
Create instant spelling lists, and more, on-line.

 

Log in and start  

designing – no need 

to install fonts!

Letter-join  
On-line Word 

Processor  
displays cursive 
fonts correctly.



RESOURCES

34   LETTER-JOIN HANDWRITING MANUAL

Word Animator 
and Word Banks

Create animations of words to save to class Word Banks

From the ‘Activities’ tab teachers can make spelling lists or 
word searches using the Word Bank words:

•	 Automatically produce look, trace and copy spelling lists 
by selecting the ‘Make Spelling List’ option. Change the 
font to the one you prefer.

•	Make an online word search using the Word Bank words 
by selecting the Word Search option from the Activities 
tab. The Word Search can also be printed out.

Select ‘New Word Bank’ 
or choose an existing 
Word Bank from the 
pull-down menu. 

Choose ‘Add a Word’ 
and enter a word. 
Click ‘OK’. You must 
write over the word to 
be able to save it.

Trace over the word 
slowly and smoothly. 
If necessary, you can 
erase and start again.

Press ‘Save’ to add the 
animated word to the  
Word Bank.

•	 Create unlimited Word Banks, for example, of topic 	
words, spelling lists or children’s names.

•	 Ready to use Word Banks (including common 
exception words) are pre-installed.

•	 Children can access their classroom’s Word Banks 	
at school on a whiteboard, or at home on tablets 	
– see opposite page.

Using class Word Banks Word Bank activities

Select a word 
Select a word, either on-screen or from the          
pull-down menu, to watch and practise.

Choose  
Select a Word Bank 
from the pull-down list.

Select ‘Fun’  
From the Letter-join 
menu choose Fun and 
then Word Bank.

Log in to Letter-join 
Use the Pupil Accounts log-in on an iPad or tablet to 
log in, and select the correct classroom name. 

‘Watch’ 
Choose ‘Watch’ to see the word being 
written on the whiteboard or tablet. 
Playback can be Freehand or Controlled.

     ‘Try’ 
      Choose ‘Try’ to practise writing        	
	 words on a whiteboard or tablet.

Activities
Pupils can choose to make any 
Word Bank into a spelling list 
or word search.

Word animations that are produced by a class teacher can be watched and practised  
at school and at home on IWBs, iPads and tablets.

Set-up Letter-join for  
children to practice at home

Letter-join includes a home log-in 
instructions letter for parents. See page 42.

For Teachers - how to create animations to share with pupils

Show Pupils how to access their classroom’s Word Banks

5

6

1

1 2 3 4

2

3

4

Teachers can create animations of project words.
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Create animations of 
words for classes to 
save and replay.
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Write it Right!  
A fun activity that 
rewards good 
handwriting

Children choose a picture, trace 
over the word and are rewarded 
with stars.

Children can print their 
handwriting results or 
return to the activity to 
have another go.  
Write it Right! includes 
three levels to practice.

To start Write it Right!, enter a 
name and then neatly trace over 
the lettering.

Write it Right! selects groups of pictures with 
words (easy, medium and hard) for children to 
trace. The activity has accompanying sounds and 
fun animations to encourage children to play and 
practice their letter shapes over again.

Completed handwritten 
words are then displayed 
with an audible cheer.

Magic Patterns 
A selection of patterns and cursive shapes for 
tracing on imaginative backgrounds.

Letter Families 
Reinforces the different letter shapes and shows 
children the correct way to write the letters.

PhonicsMatch 
A matching pairs game to beat the clock using 
cursive or printed letters. 

Word Search
Create class word banks to make word searches 
or spelling lists.

LetterLotto 
Practise recognition and orientation  
of cursive or printed letters.

Magic Words
Enter any word and trace on a choice of 
colourful backgrounds.

LetterMatch 
Helps teach the names and sounds of the  
letters of the alphabet.

Write it Right! 
A fun activity that rewards neat handwriting.
Change the font to suit your class.

FUN 
ACTIVITIES
Find under Letter-join’s ‘Fun’ tab

Colourful, touch-screen cursive handwriting  
activities for IWBs and tablets.

Fun activities
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FUN ACTIVITIES

The phoneme or grapheme is displayed along with a 
picture of the word with the phoneme highlighted.

Letter-join Phonics

Letter-join Phonic resources encompass Phase 1 
through to Phase 5. Teachers can display pictures 
of each phoneme or grapheme on the whiteboard 
and the class can hear them and watch them 
being written. 

Children can practise tracing the phonemes and 
graphemes on whiteboards or tablets and then 
play the Phonics Match game. 

Schools can choose from any of the Letter-join 
fonts for the words which accompany the 
phonemes and graphemes.

Word Search
Letter-join’s Word Searches are designed for iPads and 
tablets. They are both fun and practical, reinforcing 
spellings and are easily printed for handwriting practice.

Word searches can be automatically made from any of Letter-join’s 
pre-installed Word Banks or from a classroom Word Bank that has 
been created by a class teacher.

A4 Word Search printout 
using words from 
Phonics Phases 2 to 5.

Handwriting practice of the phoneme or grapheme 
can be on IWBs, iPads or tablets.

Phonics Phase 5.

Combine handwriting with phonics
in an easy and seamless way.

1. Choose a class Word Bank 

2. Select ‘Make Word Search’ 
from the ‘Activities’ tab.

Letter-join Word Searches include a variety of words from 
CVC through to some of the statutory ‘tricky’ spellings.

Make Word Searches from Word Banks

To support phonics learning even further, there is a fun 
matching pairs game where children can test their memory 
powers against the clock!

Phonics posters for  
classroom display

Phonics posters can be printed 
out for class displays using your 
preferred letterforms.
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Left hand menu
Content here can only be 
accessed by logging in as 
School Administrator.

The Administrator can 
choose preferred 
letterforms, download the 
fonts, the Handwriting 
Policy and other useful 
information as shown 
below.

School Handwriting Policy
School subscribers to Letter-join can download an editable Microsoft 
Word document of the Letter-join Handwriting Policy.

Back to Letter-join
Click here to go back to the 
Letter-join School Edition opening 
page where you can access all of 
Letter-join’s resources.

This is where to select your 
school’s preferred letterforms for 
cursive f, k, w, x, and z. and 
printed f and k.  

Your choices will be used across 
all of your classroom and home 
accounts and other Letter-join 
resources.

Account Information

ADMINISTRATOR SET-UP

How to distribute 
passwords for your 

pupils to use  
Letter-join at home

See page 42

Choose alternative letterforms  

Log in to Letter-join with your School 
Administrator details (sent to you by 
email) to access your school’s 
Administrator Page, shown below. 
 

The page acts as a gateway to the 
administrator’s instructions, core 
Letter-join preferences for your school 
and for naming classroom accounts.

Staff can set preferences for their 
individual classes by logging in to a 
classroom account and choosing the 
‘Info’ button. See page 4.

School Administrator Page

Left hand 
menu
Please see 

opposite 

page.

Lost passwords

School Admin 
Email us from a school 
email address: 
info@letterjoin.co.uk

Classroom Account 
Staff requiring classroom 
log-in details should 
contact their school’s 
Letter-join Administrator. 

The Letter-join fonts you 
download will use the alternative 
letterforms, chosen by your 
school. See page 6 for more 
information.

Download Letter-join fontsHome instructions
(School subscriptions only)

 Air No-lead

Print Print Plus Air Plus

No-lead

Letter-join Plus

abc

School details 
Please check all details 
are current, and update 
if necessary. 

Tablet Edition  
Tablet log-in details 
for pupils to use at 
school and at home.

Home-School 
Account
PC log-in details for 
children to use at 
school and at home. 

Info. video 
Watch what you can do 
on the Letter-join school 
Admin page.

Classroom Teacher 
Accounts 
We recommend that Class 
Names are changed to the real 
class names and that the Year 
Group is chosen for each class.

This helps pupils easily identify 
their class when logging in to 
the Pupil Account.

Pupil log-in
See page 42 for instructions for 
pupils to log in to Letter-join.
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Access for
children at home
Issuing passwords for children and their 
parents to use Letter-join at home.

Log in to Letter-join as ‘School Administrator’ and select 
‘Home Instructions’ from the left hand menu. Open the 
link to the MS Word Document letter and insert your 
home and tablet log-in details where indicated. These 
can be found on your Letter-join Admin page.

 
Naming your classes on the Admin page

To allow pupils to access resources created by their 
class teacher, please see how to change class names on 
your Letter-join Admin page (see page 40 for details). 

ADMINISTRATOR SET-UP

Add your school’s Pupil username, password and swipe 
code to the Home Instructions letter. It can be printed 
onto a school letterhead or pasted into a school 
newsletter so children can use Letter-join at home.

Home Learning Tasks 
Click the ‘Set Home Learning Tasks’ button from the 
Teacher’s Info page to create a class task.

Home Learning Packs 
There are two sets of home learning packs for each year 
group. Ideal for when children work from home. They 
can be found on the Teacher’s Info page.
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Installing Letter-join fonts on PCs and across networks           

4. To download the fonts please accept the Terms and 
Conditions and click on one, or each of the font name 
buttons, as shown below. 

The Letter-join fonts can be downloaded by subscribing 
schools by logging in to Letter-join as a School 
Administrator and following the instructions below.

IT technicians and class teachers can also download the 
Letter-join Font Guide from the Info page for more 
information about installing and using Letter-join fonts.

Letter-join desktop log-in.

1. From the Letter-join home page, log in as Administrator 
on your desktop computer. Font download options from the Administrator page.

‘Download fonts’ is in the left hand menu.

Choosing your school’s preferred letterforms.

Installing fonts on individual PCs

Installing fonts across networks

3. Select ‘Download fonts’ and follow instructions. 

2. Select your school’s preferred letterforms before 
downloading the fonts.

5. Locate where the fonts have been downloaded  
on your PC to install.  
The fonts are named Letter-join Plus, Letter-join Air Plus, 
Letter-join No-lead, Letter-join Air No-lead and Letter-join 
Print, each followed by a number relating to your choice 
of letterforms.

6. Right-click the file and choose the ‘Install’ option.
Restart MS Word so that the font is recognised.  
The font is now ready to use in Microsoft Word and 
other applications that support Contextual Alternates.

Letter-join fonts can be distributed and installed onto 
classroom PCs and laptops across a school network. 

Please consult your IT technician to distribute the fonts 
using the MSI installer option from the link on the 
Letter-join ‘Download fonts’ page.

ADMINISTRATOR SET-UP

Access to Letter-join through LearnPad:

•	 On your PC log in to LearnPad.

•	 Log in to Class Connect.

•	 Choose ‘Content’.

•	 Search for keyword ‘Letterjoin’.

Setting up Letter-join for 
LearnPad

Letter-join Home Instructions letter 

Please send home!

Home Learning
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Joined-up handwriting made easy

You can download and print 
further copies of this manual at 
www.letterjoin.co.uk/manual.pdf

Follow us on Twitter!  
#letterjoin

Apple 
Safari

Google 
Chrome

We recommend the latest versions of the these browsers:


